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LESSON-1 - Introduction

The CNC Programming Student Workbook includes a DVD with the following Videos and support files on it.

1. Self-Learning Videos
2. Discriminator BackPlot Installation Software

To view what’s on the DVD just follow the instructions below. We encourage you to take a few moments to
watch the Getting Started video on the DVD as it provides an overview of how the system works.

Just pop the DVD into your computer, the autorun feature should display the AutoPlay window. Click on the
Run CNC-Mill.exe file as shown below. Note, if this window is not displayed after putting the DVD into your
computer, go to the file manager feature on your computer and select the DVD drive and double click on the
Run CNC-Mill.exe file.

2 DVD RW Drive (D:) CNC Mill
= Videos

[] Always do this for software and games:

Install or run program from your m

i’ Run CHC-Mill, exe
Esge” Published by TechSmith Cor|

General options

Open folder to vie
) using Windowsg

Getting Started
Lesson-1 - Absolute & Increl
Lesson-2 - Introduction to C
Lesson-3 - Creating
Lesson-4 - Drilling

WWW.Camlnstructor.com

CNC Programming -
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The Menu is your easy access to the Instructional Videos that will guide you through the content and

provide you with all the information you need to get through this workbook. You will notice that there are

10 Lessons and a Getting Started link. Each Lesson matches the corresponding lesson in this workbook. Be

sure to watch the video first, it will guide you to information in the workbook.

Step 1: Watch the Getting Started Video. Don’t worry about taking notes or filling out anything in the

workbook while you watch the Getting Started Video, it is just a preview of what to

expect.

Step 2: The second item on the DVD is the Discriminator installation file. We have provided this to you free

of charge so you can install Discriminator onto your computer. Discriminator Software enables you to type

in the CNC Code (G Code) and watch what it will do. It is a handy tool to see if your
correct.

CNC Programs are

1. To access the Discriminator installation file put the DVD into your computer and locate the

Discriminator folder as shown below.

W.& » Computer » DVD RW Drive (D:) Jun 17 2013 »

[ 43 || search DvD W Drive (0.. P |

Organize ~ Burn to disc

4 . Favorites
s Downloads

). Dropbox .
6/17/13 2:52 PM File folder

6/17/13 2:52 PM File folder
6/17/13 1212 PM Setup Information
6/17/13 1212 PM Application

‘<» Recent Places
B Desktop

4[] Libraries
» .. Documents
> 1. DropBox
3 J‘, Music
[> =, Pictures
b ! Videos

Date modified Type Size I

1KB

r folder as shown a

w th

ouble click on the
creen instructions.

v‘ *5 ‘ | Search Discriminator

re)

QOrganize ~

=- O @

-

Iy Downloads
| Dropbox

Name

4 Files CL‘V

ﬂ DiscrimSett

Type Size

2 Recent Places
B Desktop
6/17/13 2:44 PM Application
' Libraries
", Documents
15, DropBox
._d”, Music
=, Pictures

!. Videos

i% Homegroup

‘& Computer
& 0S(C)
‘ -/ DVD RW Drive (D:) Jun 17 2013

6/17/13 2:44 PM Windows Installer ... 2310 KB

673 KB
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LESSON-1 - Introduction

Okay let’s get started.
Step 1 - Plug in your headphones or make sure your speakers are plugged in and turned on.
Step 2 - Put the DVD into your computer and launch the menu.

Step 3 - Click on Getting Started and watch the video through to the end. Feel free to pause and rewind the
video if you need to watch something again.

Step 4 - Click on Lesson 1 and then click on Lesson-1 — Unit-1, as indicated it is 9 minutes long.

Step 5 - Proceed through the Videos in the proper order and make sure to follow along with the Workbook.

==
N

K,

xQ

,000
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LESSON-1 — EXERCISE #1 - ABSOLUTE & INCREMENTAL POSITIONING
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LESSON-1 — EXERCISE #2 - ABSOLUTE & INCREMENTAL POSITIONING
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LESSON-1 — EXERCISE #3 - ABSOLUTE & INCREMENTAL POSITIONING
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LESSON-1 — EXERCISE #4 - ABSOLUTE & INCREMENTAL POSITIONING
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CNC PROGRAMMING
WORKBOOK

CODE FUNCTION

Rapid traverse motion; This is used for non-cutting rapid moves of the machine axis, or
rapid retract moves after cuts have been completed.

Maximum rapid motion (I.P.M.) of a CNC Machine will vary dependent on machine
model.

GO0

Linear interpolation motion; Used for cutting in a straight line under a controlled
GOo1 feedrate. Maximum feed rate (I.P.M.) of a CNC Machine will vary depending on the
model of. thesmachine.

G02 Circular Interpolation, Clockwise

GO03 Circular Interpolation, Counterclockwise

G04 Dwell

G17 Circular Motion XY Plane Selection

G20 Verify Inch Coordinate Pasitions

G21 Verify Metric Coordinate Positions

G28 Ma?chine Home (Rapid traverse) G91 is requiredifor rapid move to the G28 reference
point.

G40 Cutter Compensation CANCEL

LESSON-2
INTRODUCTION TO CNC CODES

caminstructor
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LESSON-2 - INTRODUCTION TO CNC CODES

AUTOMATIC TOOL CHANGER
STANDARD TOOL CAROUSEL

The CNC Machining Center used in this text is set-up with following tools.
All program examples and exercises in this workbook are using the tools and tool
numbers listed below.

Carousel # Tool Description
1 .125’ er Flat End Mill
2 iameter Flat End Mill

” Diameter Flat End Mill

0.500” Dia at End Mmill

0.75

5"
.250”

0.201” Di

x Tap

er Drill

r Flat End Mill

Diameter Spot \

Diamet il

ill = Number 7 drill

10

Page 10 Mill Lesson 2 - 2



COMMONLY USED PREPARATORY  CODES

CODE FUNCTION
Rapid traverse motion; This is used for non-cutting rapid moves of the machine axis, or

GO0 rapid retract moves after cuts have been completed.
Maximum rapid motion (I.P.M.) of a CNC Machine will vary dependent on machine
model.
Linear interpolation motion; Used for cutting in a straight line under a controlled

GOo1 feedrate. Maximum feed rate (I.P.M.) of a CNC Machine will vary depending on the
model of the machine.

G02 Circular Interpolation, Clockwise

GO03 Circular Interpolation, Counterclockwise

G04 Dwell

G17 Circular Mation XY Plane Selection

G20 Verify Inch Coordinate Positions

G21 Verify Metric Coordinate Positions

G28 Ma?chine Home (Rapid traverse) G91 is required for rapid move to the G28 reference
point.

G40 Cutter Compensation CANCEL

G41 Cutter Compensation LEFT©f theprogrammed path

G42 Cutter Compensation RIGHT of the programmed path

G43 Tool Length Compensation

G49 Tool Length Compensation'\CANCEL

G53 Positions'the' machine axis relative to Machine Hame._lt'is hon modal.

G54 Work Coordinate #1 (Part zero offset location)

G80 Canned Cycle CANCEL

G81 Drill Canned Cycle

G82 Spot Drill Canned Cycle

G83 Peck Drill Canned Cycle

G84 Tapping Canned Cycle

G90 Absolute Programming Positioning

G91 Incremental Pregramming Positioning

G98 Canned Cycle Initial Point Return

G99 Canned Cycle Rapid (R) Plane Return

Mill Lesson 2 - 3 Page 11



COMMONLY USED MISCELLANEQOUS CODES

CODE FUNCTION

The MO0O code is used for a Program Stop. The spindle stops and the coolant is turned
MO0 off.
Pressing CYCLE START again will continue the program.

The MO01 code is used for an Optional Program Stop command.

Pressing the OPT STOP key on the control panel signals the machine to perform a stop
Mo01 command when the control reads an MO1 command. It will then perform like an MOO.
Optional stops are useful when machining the first part to allow for inspection of the
part as it is machined

Starts the le used for most machining. Must have a spindle speed
defined.
The MO03 i
change

mo3 rn the spindle on at the beginning of program or after a tool

Mo04 COUNTERCLOCKWISE. Must have a spindle spee& ine

offat the end of progra
n it off.

automatically stop the spindle, S ve up to the machine zero
selected tool will be put i e coolant pump will turn off

M30 t to the beginning of program.

Note: Only one “M” code can be used per line. And the M-codes will be the last command to be executed in
a line, regardless of where it is located in that line.

Page 12 Mill Lesson 2 - 4



EXAMPLE OF PROGRAM

Programs must begin and end with “%” depending

%
on the type of control.

Letter “O” and up to a five digit program number.

“.n

000023 Blocks are always terminated by the “;” symbol:
End of Block (EOB)

Nnn - Sequence Number

N10 G20 .
G20 - Verify Inch
Startup
GOO - Rapid Traverse Block
G17 - X, Y Circular Plane Selection (Machine
G40 - Cutter Compensation Cancel Default
N20 GO0 G17 G40 G49 G80,G90 . )
G49 - Tool Length Compensation Cancel Setting)

G80 - Canned Cycle Cancel
G90 - Absolute Programming

T8 - Tool number #8 to be loaded into the spindle.

N30 T8 MO06
MO6 - Tool Change

GO0 - Rapid Traverse

G90 - Activates control to'bein ABSOLUTE.

G54 - Selectswork coordinate offset system No. 1
N40 GO0 G90 G54 X1.0 Y1.0 S4000 MO3 | X__ - Axis move toiinitial X position.

Y__ - Axismove to initial Y position.

S4000# Spindle speed 4000 RPM for this tool.

MO3 = Turns,the spindle on in a clockwise direction

G43,- Tool Length Compensation: Recognizes the
tool length offset value stored in the Hnn code offset
display register in the offset length display.

H8 - Defines to the control the offset register the
N50 G43 H8 72.0 tool offset value is stored in.

* Tool Length offset # = Tool #

Z2.0 - Informs the control to move from full spindle
retract to this Z value and apply the tool length
offset.

Mill Lesson 2 - 5 Page 13



EXAMPLE OF PROGRAM

GOO - Rapid Traverse

N200 GOO Z2.0
Z2.0 — Retracts tool to 2.0 above part zero

N210 MO5 MO5 — Turn off spindle

N220 G28 G91 Z0 G91 - Incremental Programming
G28 - Machine Zero Return Send to machine
Z0 - Z axis in the up direction to

machine zero

zero Z-axis first to

* N220 G53 20 avoid any crash.

*G53 is another way

achine Zero Return .
to return to machine

is to machine zero

N230 G28 X0 YO

zero

* N230 G53 X0 YO to machine zero

N240 M30

0 — End of Program and Reset

0 2.0 above part

N120 Send to machine

zero Z-axis first to

N130 avoid any crash.

N140

N150 T9 MO06 Tool Change - Tool #9

N160 GO0 G90 G54 X1.0 Y1. Turn on the spindle and Rapid traverse to X1. Y1.

N170 G43 H9 Z2.0 Tool Length compensation for Tool #9 (H9)

*G53 - Positions the machine axis relative to Machine Home. It is non modal.

Page 14 Mill Lesson 2 - 6



RAPID AND LINEAR INTERPOLATION

GOO RAPID TRAVERSE

This code is used for rapid motion of the cutter in air to traverse from one position to another as
fast as possible. This code will work for all axis motion up to three axes at once.

This GOO code is modal and causes all the following blocks to be in rapid motion until another
Group 01 code is specified. The actual rapid federate is dependent on the machine.

Generally, rapid motions "will not" be in a straight line. All the axes specified are moved at the
maximum speed and will not necessarily complete each axis move at the same time. It activates
each axis drive motor independently of each other and, as a result, the axis with the shortest move

will reach its destination first. So yo be careful of any obstructions to avoid with this type

of rapid move.

. 3 itioning the cutter in ‘fresh air’.

for all axis motions

occur up

three axes‘on

e time and proce nation and arrive

simultaneously at t feedrate.

ommand is used F co

*

To program a nd is modal and may be specified in a

previous b

GO1 is used for
e Drilling a hole

e Machining a slot

e Machining a profile

Mill Lesson 2 - 7 Page 15




LESSON-2 - CNC - PART #1
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LESSON-2 - CNC - PART #1

= WORK OUT THE X AND Y COORDIANTES FOR HOLES 1,2 AND 3
= XOYO is at the centre of the part

e 3] —————————— ==

t—— | —==

gj 250 (3) THRO

Mill Lesson 2 -9 Page 17



LESSON-2 - CNC - PART #1

= PROGRAM TO SPOT DRILL THE THREE HOLES ONLY USING A COMBINATION OF
GO0 AND G01 (CANNED CYCLE DRILL WILL BE USED LATER)

Below is the program to spot drill the three holes with an explanation of each block
Use a 0.375” diameter Spot Drill Tool # 6

Spindle Speed = 2750 Feed rate =11 IPM

Spot Drill Depth = Z-0.150”

X0YO0 is at the centre of the part

Z=0is the top of the part.

Information inside the parenthesis ( ) is a comment.

The CNC control will ignore all text between the parenthesis

% (Program must begin and end with a %)

( Program #1 - CNC-PART-1-SPOT DRILLING ONLY )

1.0 Y0.875

G01 Z-0.15
N130 G53 GO0 Z0 MO

0 X-15.0 and YO0)

the beginning)
ith a %)

N150 M30

Program en*win

(Program must

%

=]
=
S

X0 YO

@ .250 (3) THRU

Page 18 Mill Lesson 2 - 10
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LESSON-3 - CNC - PART #1

= PROGRAM TO SPOT AND DRILL THE THREE HOLES USING A COMBINATION OF
GO0 AND G01 (CANNED CYCLE WILL BE USED LATER)

e Below is the program to spot and drill the three holes with an explanation of each block
e Use a 0.375” diameter Spot Drill Tool # 6

e Spot Drill Spindle Speed = 2750 Feed rate =11 IPM

e Use a 0.250” diameter Drill Tool # 7

e 0.250” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
e Spot Drill Depth = Z-0.150”

e  Drill Depth =Z-0.350”

e  XOYO is at the centre of the part

e Z=0is the top of the part.

% (Program must begin and end with a %)
02 ( Program #2 - GNC-PART-1-SPOT AND DRILLING )
N10 G20 (Inch proegramming)

N20 GO0 G17 G40 G49 G80 G90 (MACHINE DEFAULT SETTING)

(SPOT DRILL 0.25” HOLES)

N30 T06 M06 (T6-Select.tool number 6 to be loaded M06-Activates the tool changer)

N40 GO0 G90 G54/X-1.0 Y-0.875 S2750 M03 (Rapid to the X and Y position of Hole #1 and turn on the
spindle at 2750 RPM)

N50 G43 H06 Z0.1 (G43 - Activate the toolfoffset.value stored in HO6 and rapid to Z0.1)

N60 GO1Z-0.15F11.0 (Hole #1 - Feéd down to Z depth at 11 inches per minute)

N70{ G00 Z0.1 (GOO- Retract.out of hole #1 at rapid to 0.1 above thetop.of the'work piece)
N80. X0 YO (G00.is modal - Move at rapid in the X and Y. axis to Hole #2)

N90 | GO1 z-0.15 (Hole #2 - Feed down to Z depth at 11'inches per minute, Feed rate is modal)
N100 GO0 z0.1 (G00-Retractiout of hole #2 at rapidito 0.1 above the top of the work piece)

N110 X1.0 Y0.875 (GO0 is modal - Move at rapid in the X and Y axis to hole #3)

N120 GO1 Z-0.15 (Hole #3 - Feed down to Z depth,at 11'inches per minute, Feed rate is modal)
N130 G53 GO0 Z0 MQ5 »(G53 — Machine Zero pesitioning, noh modal. Rapid to machine zero in Z, switch
spindle off)

N140 G53 X-15.0Y0 (G53 — Rapid in relation'to machine zero X-15.0 and YO0)

(DRILL 0.25” HOLES)

N160 TO7 M06 (T7-Select tool'number7 to be loaded M06-Activates the tool changer)

N170 GOO G90 G54 X-1.0 Y-0.875'S4500/MO03 (Rapid to the X and Y position of Hole #1 and turn on the
spindle at 4500 RPM)

N180 G43 H07 Z0.1 (G43 - Activate the tool offset value stored in HO7 and rapid to Z0.1)

N190 GO1 Z-0.35 F15.0 (Hole #1 - Feed down to Z depth at 15 inches per minute through part)

N200 G00 20.1 (GOO0- Retract out of hole #1 at rapid to 0.1 above the top of the work piece)

Page 20 Mill Lesson 3 -2



LESSON-3 - CNC - PART #1 - Continued

N210 X0 YO (GO0 is modal - Move at rapid in the X and Y axis to hole #2)

N220 GO01 Z-0.35 (Hole #2 - Feed down to Z depth, at 15 inches per minute, Feed rate is modal)

N230 G00 Z0.1 (GOO- Retract out of hole #2 at rapid to 0.1 above the top of the work piece)

N240 X1.0 Y0.875 (GO0 is modal - Move at rapid in the X and Y axis to hole #3)

N250 GO1 Z-0.35 (Hole #3 - Feed down to Z depth at 15 inches per minute, Feed rate is modal)

N260 G53 GO0 Z0 M05 (G53 — Machine Zero positioning, non modal. Rapid to machine zero in Z, switch
spindle off)

N270 G53 X-15.0Y0 ) machine zero X-15.0 and YO0)
N270 M30

%

bgram to the beginning)

gin and end with a %)

\xu Yo

Mill Lesson 3 - 3 Page 21
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LESSON-4 DRILL CANNED CYCLE

G80 CANCEL CANNED CYCLE

A canned cycle is canceled with G80.

A canned cycle permits multiple function programming on one block.

G81 CANNED CYCLE DRILL

Rapid X location (Optional)
Rapid Y location (Optional)
Z-depth (Feed to Z-depth starting f

m 20 N < X

ee inches/min

reduce the length of pr.

Canned Cycle Drill

with any oth motions un

is
t

This G code permits the inclusion ultiple axis motions on one block of program. It is used t

figure below shows the axis motions that are includ

affected. \
and Y, then to a height part at

Format: G99 G81 Z-0.625 RO.1 F10.

rom R Plane)

R-PI id point to start feeding)

he e the cutter feeds

retracts at rapid

Positio

*

Initial
Z t

R Plane

'

\

,
i

?

Zo
R Value
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DEEP HOLE PECK DRILL CANNED CYCLE

G83 DEEP HOLE PECK DRILL CANNED CYCLE
Format: G99 G832Z-2.5Q0.5R0.1F10. / G99 G832Z-2.1810.5J0.1 K0.2 RO.1 F9.

X* Rapid X-axis location

Y* Rapid Y-axis location

Z Z-depth (feed to Z-depth starting from R plane)

Q* Pecking equal incremental depth amount (if I, J and K are not used)

I* Size of first peck depth (if Q is not used)

J¥ Amount reducing each peck after first peck depth (if Q is not used)

K* Minimum peck depth (if Q is not used)

P Dwell time at Z-depth
R-plane (rapid p

F Feedrat inc

* Indicates o

art feeding)
er minute

used for drilling when the tool must be withdrawn p

the hole. ‘

rapid to the R Pl owards the Z depth i x
e and bac the re drilling was interru afi h

This G code is similar ta
to allow chipsto b
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LESSON-4 - CNC - PART #1

= CREATE THE PROGRAM TO SPOT AND DRILL THE THREE HOLES USING CANNED

CYCLE G381

= Use a 0.375” diameter Spot Drill Tool # 6

=  Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

= Use a0.250” diameter Drill Tool # 7

= 0.250” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
= Spot Drill Depth =Z-0.150"

=  Drill Depth =Z-0.350”

= XOYO is at the centre of the part

= 7=0is the top of the part.

% (Program must begin and end with a %)
03 ( Program #3 - CNC-PART-1-SPOT AND DRILLING USING CANNED CYCLE DRILL G81)
N10 G20 (Inch programming)

N20 GO0 G17 G40 G49 G80 G90 (MACHINE DEFAULT SETTING)

N30 T06 M06 (Te-Select tool number 6 to be loaded M06-Activates the tool changer)

N40 GO0 G90 G54 X-1.0 Y-0.875S52750M03  (Rapid to the X and Y position of Hole #1 and turnon'the
spindle at 2750 RPM)

N50 G43 HO06 70.1 (G43'- Activate the tool offset value stored in H06 and rapid to Z0.1)

N60 G99 G81 Z-0:15 RO.1 F11.0 (Hole #1 — G81 - Feed down to Z depth at 11 inches per.minute,
and then retract at.rapid to Z0.1, this is the R0.1walue:
G99 réturns the drill'tip to the R value aftér drilling.each hole)

N70 XOryo. (Hole #2 - Move at rapid in the X and Y axis to Hole #2. Feed downtoZ depth at 11
inches per minute and thensetract at rapid to 20.1)

N80 “X1L0Y.875 (Hole #3 - Move at rapid in the X and Y axis to Hole #3. Feeddown to Z depth at 11
inches per minute andithen retract at rapidito 20.1)

N90'| G80 (Cancel Canned Cycle Drill)

N400 G53 GO0 Z0 M05 (G53,— Rapiditoymachine zero in Z, switch spindle off)

N110 G53 X-15.0 YO [ (G53 = Rapid in relation to machine zero X-15.0'and YO0)

(DRILL 0.25” HOLES)

N120 TO7 MO06 (T7-Select tool number7 to be loaded'M06-Activates the tool changer)

N130 GO0 G90'G54 X-1.0 Y-0.875 S4500.M03' (Rapid to the X and Y position of Hole #1 and turn on the
spindle at 4500 RPM)

N140 G43 HO7 Z0.1 (G43 - Activate the toel offset value stored in HO7 and rapid to Z0.1)
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LESSON-4 - CNC - PART #1 - Continued

N150 G99 G81 Z-0.35 R0.1 F15.0 (Hole #1 — G81 - Feed down to Z depth at 15 inches per minute,
and then retract at rapid to Z0.1, this is the R0.1 value.
G99 returns the drill tip to the R value after drilling each hole)

N160 XO0. YO. (Hole #2 - Move at rapid in the X and Y axis to Hole #2. Feed down to Z depth at 15
inches per minute and then retract at rapid to 20.1)

N170 X1.0Y.875 (Hole #3 - Move at rapid in the X and Y axis to Hole #3. Feed down to Z depth at 15
inches per minute and then retract at rapid to 20.1)

N180 G80 (Cancel Canned Cycle Drill)

N190 G53 GO0 Z0 MO5

N200 G53 X-15.0Y0
N210 M30

%

R
’ﬂ'\

\—xu Yo

@ .250 (3) THRU
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LESSON-4 — WHAT COULD GO WRONG?

IDENTIFY SOME OF THE COMMON PROBLEMS THAT COULD RESULT IN A

SCRAPPED PART

Do you have X0 YO Z0 in the correct position?

Is the spindle switched on and off at the appropriate time

Did you use the correct X and Y coordinates for the holes?

Did you use the correct tool numbers?

Did you use the correct tool length offset number (H??) for the tool?
Did you cancel any canned cycles with G80?

Are the feed-rates correct?

Is the Z depth in the canned cycle block set to a negative value?

Is the R value in the canned cycle block set to a positive value?
What is the difference between Z2 and Z2.0? No decimal point???
What is the difference between F d F10.0? No decimal point???
What else?

— = = 25K

N

CNC - Part #1
SCALE 1.000
CAMIn MATL: 3 x 3 x 25 ALUMINUM - T6061
DRW BY: MM. | DATE: 18-Feb-11
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CNC PROGRAMMING
WORKBOOK

to >
T T 9
Ee —— e e e e e e e g
gy Ry i
15 ! | | f
! ! ! 1.0
I 4 I 1 | 8 '}'
T - T |
3.0 gl O )ﬁ-—-— - &
! | !
! Q ! 1.0
| a i
_@’?_7{_@?_ sy J!
/ ;}4
x’f /fr
o/
X0 YO £ 75 (9) THRU

LESSON-5
DRILLING USING CANNED CYCLES - CONTINUED

caminstructor
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LESSON-5 - CNC - PART #2

L-EW-H731va | WW AS

19091 - WNNIWNTY §T * £ * £ LYW WODH01nsu[\Wy D)

0001 3725

(# HEd - DND

S¢ —= =

1H¥d 40 dO1
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Page 30



LESSON-5 - CNC - PART #2

=  WORK OUT THE ABSOLUTE COORDINATES FOR THE NINE HOLES
= XOYO is at the centre of the part

=—""— 3.0

f— 1.5 ——==

|

1.

A

1.0

i

1.0

1

ZQ:’ .25 (9) THRU

;00
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LESSON-5 - CNC - PART #2

= CREATE THE PROGRAM TO SPOT AND DRILL THE NINE HOLES USING CANNED

CYCLE G381

= Use a0.375” diameter Spot Drill Tool # 6

=  Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

= Use a0.250” diameter Drill Tool # 7

= 0.250” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
= Spot Drill Depth = Z-0.150"

=  Drill Depth =Z-0.350”

= XOYO is at the centre of the part

= 7=0is the top of the part.

= Type up your program and check it for correctness using the Backplot software.

%
04 ( Program #4 - CNC-PART-2-SPO

RILLING USING CANNED CYCLE DRILL G81)

N10 G20
N20 GO0 G17 G40 G49 G80 G90
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LESSON-5 - CNC - PART #2 - Continued

X
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LESSON-5 - CNC - PART #2 — TYPING UP YOUR PROGRAM

USING WINDOWS NOTEPAD

= Use Windows Notepad to type up your CNC program

1. Launch Windows Notepad Start>All Programs>Accessories>Notepad.

@ Accessibility 3
@ Broadcom L4 @ Cammunications L4
[@ Cakalyst Conkrol Center 3 [@ Entertainment 3
i@ el » | (@ microsoft Interactive Training  »
[@ Dell Accessories v | ') Address Book
@ Zames 4 'lg Caloulator
@ Google Deskkop [l B Command Prompt
@ Mouse Suite 3

2. Select File Save As...

I Untitled - Notepad
File Edit Format Wiew Help
e

Chrl+h
Qpen... Chrl+D
Save Ctrl+5

Page Setup...

Print,.. C

ile name:

Save az type:

Encoding:

program, ALLCAPI
m 04 this is a letter.

File Edit Format View Help

A

od  Program #4 - @

W10 G20

W20 GO0 Gl7 G40 49 E LACHIME DEFAULT SETTIMG)
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LESSON-5 - CNC - PART #2 — TYPING UP YOUR PROGRAM

USING WINDOWS NOTEPAD

9. When you have completed typing your program Save your file, File>Save or the shortcut Ctrl+S.
File Edit Format Miew F

Mew Chrl+h
Qpen... ‘ Chrl+0

Save As,.,

Page Setup...
Prink... Ctrl+P

Exit:

e Now you can check for any Letter O’s in your CNC program. Please Note there should not be any
letter O’s in your CNC program, G Zero Zero” not G Letter O!

10. Select Edit>Find.
Edit Format  Wiew Hel
Jndio Chrl+2

ik Chpl+3

O
= & \\
r ,Q

Chrl+G
No the Fi ext button. There will be some
e program number at the start of the
d by parenthesis (). But for the coding no

Select all  Crhrl+-a&
Time/Date FS

Find what:

[ Match caze

12. | f you do find any letter O’s change them to a Zero.
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LESSON-5 - CNC - PART #2 — TYPING UP YOUR PROGRAM

USING WINDOWS NOTEPAD

13. When you have checked your program select File>Save your file or the shortcut Ctrl+S.

File Edit Faormat Miew
T Chrl+M
Qpen. .. ChElHO
Save Chrl+3S
Save As...

Page Setup...
Print... Chrl+P
Exik

14. You may require a print of your CNC program to do this select File>Print or the shortcut Ctrl+P.
15. Select which printer you wish to send the file to and then hit the Print button

General

Select Printer

<

Statuz: Offlirne
Location:
Comment:

g‘é Microsoft ¥PS Docurment

Start>All

. To open your

File niame:

Filez of type:

Encoding:

[ Files

NS
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LESSON-5 - CNC - PART #2 - BACKPLOTTING

= Use Discriminator Backplot software to check for correctness
Note: If you do not have Discriminator installed on your computer please go to the last page of the
appendix for installation instructions.
1. After typing up your program in Notepad launch the Discriminator application by clicking on the icon
on your desktop or Start>All Programs>Discriminator> Discriminator

. Discriminator

ML Discriminator 44—

2. Click OK to any warnings you receive.
3. Click on File>Open and browse to your file location and select the CNC file to plot.

i vscrmiveic R
File | View Scheme Tools Help
1 Mew Ctrl+M
= <
= DFI'EH... *— '

[ (® RecentFiles 1

5 Exit ]

4. After selecting the % ppens up in a separate window.

File Edit View S5g

WL B E =2 %0 N

CNC ; [ SolSE | (=3 B
% o i
0002; Q4 ( Prog Cl AR OT AND DRILLING USING NED CYCLE Ihy =
o0z N10 G20 .
oo+ N20 GO0 GI7 G 49 G80 G0
N30 TO6 M06
40 GO0 G90 G54 X
3 H6 Z0.1

9 G81 7-0.15 R0O.1 F11.0

52750 M03

at the top of the screen to launch a plot of

w2 arariB P RE = -0 - BED =&

Mill Lesson 5 -9 Page 37



Page 38

6. When the plot screen opens up hit the Maximize button.

B[ G:\Camlnstructor-In-Work\CNC-Text\CNC-Part-Progra... Eml
Mili-v - B | B)- 33 VB8 | [ | D o4 R () [Medmiz]

‘%\ 3
9

Niew Fit [Shift@a@hck] All s

8. You plot shou
movement in

below. The poin! on ttt reen shot below is the G53 X-15.0 YO

_ - - - s
z — - . -
. .
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9. Click the right mouse button on the main graphics plot screen and select Views>Front.

[Z} Select
5 i
&, Fence
~ Pan
{0 Rotate
Q. Zoom
Views » | Top Ctrl+T
[ Front Ctrl+F
H Right  Ctrl+R
@ Isometric  Ctrl+]

10. Return to a Top view by clicking the right mouse button on the main graphics plot screen and select
Views>Top.

11. Experiment with the various display f

tions at the top right of the screen.

12. Review and expe m he various toolbar options. P N
Mt e FIR- ¥ 2208 9 o By & g"_

the New

13. You can Disc nator instead of Wing epad to type up your CNC
o create a new file and type program in the new doc

Scheme  Tools  Window  Help
Document

1N M= =Y

S X -

= | 89 |am a3 N2 DR
—

- & Favorites
ﬁ Today
8] Yesterday
- Week
(-] Older

e your CNC program h
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LESSON-5 - CNC - PART #3

=  PART #3 IS SIMILAR TO PART #2 BUT HAS DIFFERENT DIMENSIONS FOR THE

HOLE CENTRES

o

ZZ

b
d

6 ‘ TOP OF PART

3.0

CNC - Part #3

CAMInstructor. COM

| DATE: 24-Mar-11

TL: 3 x 3 x 25 ALUMINUM - Te0s6]

I
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LESSON-5 - CNC - PART #3

=  WORK OUT THE ABSOLUTE COORDINATES FOR THE NINE HOLES
= XOYO is at the centre of the part

Mill Lesson 5 - 13 Page 41



LESSON-5 - CNC - PART #3

= CREATE THE PROGRAM TO SPOT AND DRILL THE NINE HOLES USING CANNED

CYCLE G381

= Use a0.375” diameter Spot Drill Tool # 6

=  Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

= Use a0.250” diameter Drill Tool # 7

= 0.250” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
= Spot Drill Depth = Z-0.150"

=  Drill Depth =Z-0.350”

= XO0YO is at the centre of the part

= 7=0is the top of the part.

= Type up your program and check it for correctness using the Backplot software.

%
05 ( Program #5 - CNC-PART-3 - SP

RILLING USING CANNED CYCLE DRILL G81)

N10 G20
N20 GO0 G17 G40 G49 G80 G90
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LESSON-5 - CNC - PART #3 - Continued

<
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LESSON-5 - CNC - PART #3 - BACKPLOTTING

Page 44

Use Discriminator to check for correctness
1. After typing up your program in Notepad launch the Discriminator application by clicking on the icon
on your desktop or Start>All Programs>Discriminator> Discriminator

. Discriminator

BC Discriminator <4

2. Click OK to any warnings you receive.
3. Click on File>Open and browse to your file location and select the CNC file to plot.

B vsciveio
File | View Scheme Tools Help
1 Mew Ctrl+M
= Open.. “—

(O RecentFiles

@ bt

4. After selecting the CN

File Edit View Scheme

E < >
DES-EwEE MEBES-&-BEDLR

E"‘%'E ——— o

- 5 Favorites

0001° :
ponz o
0003 =
0004
0005 ;
0006 |
0007 |

N
I at the to of the screen to launch a plot of
i n and selects the icon to View Fit.

el the screen shot below is the G53 X-15.0 YO

.- &__f---a
=7 \ J,-f X
e ——
< ™
.’J \"\
¢ & 2
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LESSON-5 - CNC - PART #4

L-ay-57 31vd | WW AS MY
19091 - WNNIWNTY ST X £ % £ LYW
D001 305
¥# Hed - DND

— = = (58

d30vds In03
NYHL

1dvd 40 401
OH3Z Z

| %m ]

(oL) v/ b

WODH0PNIsUlINYD
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LESSON-5 - CNC - PART #4

=  WORK OUT THE ABSOLUTE COORDINATES FOR THE ELEVEN HOLES
= XOYO is at the centre of the part
= Use Trigonometry to work out the center positions of the holes or draw the part up on a CAD system
and then identify the center positions of each hole.

3.00

z ZERO—/

TOP OF PART

l— @ 1/4 (10)
THRU
EQUI SPACED

#1/4 THRU 250 “" L*

CNC - Part #4
SCALE 1000 ‘
structor.COM MATL: 3 x 3 x 25 ALUMINUM - T6061
DRW BY: MM. [DATE 25-Apr1 \
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LESSON-5 - CNC - PART #4

= CREATE THE PROGRAM TO SPOT AND DRILL THE ELEVEN HOLES USING CANNED

CYCLE G381

= Use a0.375” diameter Spot Drill Tool # 6

= Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

= Use a0.250” diameter Drill Tool # 7

= 0.250” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
= Spot Drill Depth = Z-0.150"

=  Drill Depth =Z-0.350”

= XOYO is at the centre of the part

= 7=0is the top of the part.

= Type up your program and check it for correctness using the Backplot software.

%
099 (CNC-PART-4 - SPOT AND DRILLING

CANNED CYCLE DRILL G81)

N10 G20
N20 GO0 G17 G40 G49 G80 G90
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LESSON-5 - CNC - PART #4 - Continued
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CNC PROGRAMMING

WORKBOOK
+Y
T\*— | —.—/ — i
N T/
Cos

\EI

T
||
¢
=
4~
v

/

DXOYO f— 7 175 —<4——»

LESSON-6

STRAIGHT LINESMILLING - LINEAR
INTERPOLATION

caminstructor
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LESSON-6 — STRAIGHT LINE MILLING

LESSON-6 — EXERCISE #1 - ABSOLUTE & INCREMENTAL POSITIONING

?.500
ENDMILL

HE POINT O (ORIGI, SC E ENDMILL PATH FRO
O THE POINT O USING G 91. CUTTER DIAMETER

Olm|locojUnn|H| W |N|=|O
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LESSON-6 - CNC - PART #5

L-EW+T 31vA | WW AS M

19091 - WINNIWNTY S * £ * E-LINVW

000 41¥I5

S# HEd - DND

8¢ ——— &=
Selb’ =

14vd 40 401
0Z

Page 51

Mill Lesson 6 - 3



LESSON-6 - CNC - PART #5

= WORK OUT THE ABSOLUTE COORDINATES FOR POSITION 1, 2 AND 3

= XOYO is at the lower left corner of the part
= These X and Y coordinates will be used to machine the L shaped slot

Positon1 — / R25 (3)

osition 2 3.0
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LESSON-6 - CNC - PART #5

=  PROGRAM TO MACHINE THE “L SHAPED” SLOT Posiion 1 R25 ()
= Use a0.5” diameter End Mill Tool # 4 L
=  Speed =3050 Feed rate =20 IPM ' 3
* XOYOis at the lower left corner of the part oostions b
= 7=0is the top of the part. 2 a
= The slot depth is 0.125” r g
=  Enter the part at Position 1 and sink to depth using linear Oi/ 1
interpolation GO1 T e e N

= Then move to Position 2 and finally Position 3

% (Program must begin and end with a %)
06 ( Program #6 — Part #5 — STRAIGHT LINE MILLING)
(T4 -1/2 FLAT ENDMILL - H4)

N10 G20 (Inch programming)
N20 GO0O G17 G40 G49 G80 G90 (MACHINE DEFAULT SETTING)

N30 T4 M6 (T4-Select tool number 4 to be loaded MO06-Activates the tool changer)
N40 GO0 G90 G54 X0.75 ¥2.5 S3050.M3"(Rapid to the X and Y to Position #1 and turn on the spindle at
3050 RPM)

N50 G43 H04 70.1 (G43 - Activate the tool offset value stored in H04 and rapid to 70.1)

N70 G1 Z-0.125 F10. (Pasition #1 - Feed down to Z'depth at 10 inches per minute)

N80 Y0.75F20.0 (Move to Position #2 @t 20 inches per minute)

N90 X2.375 (Move to Position#3 - at 20 inches per minute)

N1007Z0.1 F10:0 (Retract out of the partat feedrate to 0.1 above the topof the work piece)
N120 MO5 (Spindle off)

N130 GO0 G91 G28 Z0 (G28 — Machine Zero positioning. Rapid to machine zero in Z)

N140 G28 X0 YO (G28,— Rapididnrelation to machinezero X0,and YO0)

N150 G90 (RETURN TO ABSOLUTE PROGRAMMING)

N160 M30 (Program end rewind program to the beginning)

% (Program must begin andend with a %)

In earlier programs we used G53 to return the:machine to coordinates in relation to the Machine Zero
(home position). G28 is another.code that will accomplish this. G28 is a more common way to send the
machine to machine zero, it will work on.many different types of CNC machines.

As you can see above at block N230, G28 is activated in G91 incremental mode, and then at block N150 the
program is returned to G90 absolute mode.
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LESSON-6 - CNC - PART #6

L-EW-HZ 31va |

WW -Ad Md

12091 - WNNIWNTY

SU*EXETUVW

0001 J1v25

9# HEd - DND

S¢° —=
Sel” —=

[———

bty

WODH0PNIsUWY D
0 — ==
ge o]

SLE ——=

S’

AOX
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LESSON-6 - CNC - PART #6

= WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE CONTOUR

= XOYO is at the lower left corner of the part
= Use a0.5” diameter End Mill Tool # 4
= Start at X-0.5 Y3.125 and machine the contour in a clockwise direction — climb milling

fe———— 2 05 e

10

11
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LESSON-6 - CNC - PART #6

=  PROGRAM TO MACHINE THE CONTOUR
= Use a0.5” diameter End Mill Tool # 4
= Speed = 3050 Feed rate =20 IPM
=  XOYO is at the lower left corner of the part
= 7=0is the top of the part.
=  Machine the contour at a depth is 0.125”

% (Program must begin and end with a %)
08 ( Program #8 - CNC-PART-6 - STRAIGHT LINE MILLING)
(T4-1/2 FLAT ENDMILL - H4)

N10 G20 (Inch programming)

N20 GO0 G17 G40 G49 G80 G90 (MAC AULT SETTING)

be loaded M06-Activates the tool changer)

N40 GO0 G90 G54 X-0.5Y3. 125 S3C apid to the X and Y to start Position #1 and turn on th
spindle at 3050 RPM)

tool offset value stored in H04 and rapid to Z0.1)

N50 G43 HO4 70.1

N60 G1 Z-0.125 F10. at 10 inches per minute) ‘

N70 X1.375 F20.0 per minute)

N80 Y1.75

N140YO0

N150 X0.125

N160 Y3.37
N170 Z0.1 F10
N180 M05

N200 G28 X0 YO

N210 G9S0
N220 M30

% (Program must begin and end with a %)
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= WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

LESSON-6 - CNC - PART #7

POSITIONS TO MACHINE THE CONTOUR

= XOYO is at the lower left corner of the part
= Use a0.5” diameter End Mill Tool # 4

= Start at X-0.5 Y3.0 and machine the contour in a clockwise direction — climb milling

2.50

X0y

.25

f— 2 37— =

—= .75

@ 2

&

i ]
3-Y \¥/
3.0
625 ==
1.75
75
i
i
250
2.625
3.0
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LESSON-6 - CNC - PART #7

= CREATE THE PROGRAM TO MACHINE THE CONTOUR

= Use a0.5” diameter End Mill Tool # 4

= Speed = 3050 Feed rate =20 IPM

= XOYO is at the lower left corner of the part

= 7=0is the top of the part.

=  Machine the contour at a depth is 0.125”

= Start at X-0.5 Y3.0 and machine the contour in a clockwise
direction — climb milling

= Type up your program and check it for correctness using the
Backplot software.

%
0009 ( Program #9 - CNC-PART-7 - STRAIGHT LINE MILLING)
N10 G20

N20 GO0 G17 G40 G49 G80 G
N30
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LESSON-6 - CNC - PART #8
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LESSON-6 - CNC - PART #8

=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE CONTOUR

=  XOYO is at the lower left corner of the part
= Use a0.5” diameter End Mill Tool # 4
= Start at X0 Y-0.375 and machine the contour in a clockwise direction — climb milling

J5 —p==e

10

11
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LESSON-6 - CNC - PART #8

= CREATE THE PROGRAM TO MACHINE THE CONTOUR
= Use a0.5” diameter End Mill Tool # 4
= Speed = 3050 Feed rate =20 IPM
=  XOYO is at the lower left corner of the part
= 7=0is the top of the part.
=  Machine the contour at a depth is 0.125”
= Start at X-0.5 Y3.0 and machine the contour in a clockwise direction —
climb milling
= Type up your program and check it for correctness using the Backplot software.

%
010 ( Program #10 - CNC-PART- 8 - STRAIGHT LINE MILLING)

N10 G20
GO0 G17 G40 G49 G80 G0 (MA

AULT SETTING)
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CNC PROGRAMMING
WORKBOOK

LESSON-7
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LESSON-7 - CIRCULAR INTERPOLATION -

= In the next series of circular interpolation exercises you will explore how to
machine arcs and complete circles.
= GO02 and GO03 allow the machining of circles and arcs

When the machine is required to move in a straight line under a controlled federate, linear interpolation is
used GO1. When it is necessary to machine in a circular motion in any plane (XY, YZ, XZ) circular interpolation
is used GO2 and GO3.

All circular interpolation moves are defined using three pieces of information.
1. DIRECTION OF TRAVEL: CLOCKWISE G02, COUNTER CLOCKWISE G03
2. PROGRAMMIED END POINT OF-THE ARC

3. ARC CENTER: INCREMENTAL DISTANCE FROM START POINT TO ARC CENTER (I, J, KORR
FOR RADIUS, 1,J AND K ARE NOT USED)

=  When trying to figure out a circular interpolation move answer these three

questions:
l. What is the direction of travel, clockwise or counterclockwise — G02 or G03?
1. Whereds the programmed end point?
Il. Whatis the'incremental distance from the'start of the arc to the center of the arc.being machined —
| andJvalues?

4.000
——ARCSTART POINT (3.0.4.25)

L R1.250

1.250

ARC CENTER (3.0)3.0) ARC END POINT (4.25,3.0)

R.750 l
4,00 [
ARC START POINT (3.0,1.75) '7*50
! 2,000

ARC CENTER (3.0,1.0)

X0 YO

PARTORIGIN i ARC END POINT (2.25,1.0)

]
Egbi?\ﬁL G02 X4.25 Y3. 10. J-1.25
START/FINISH 2.000 G03 X2.25 Y1. 10. J-.75 XY PLANE

G02 & GO3 Circular Interpolation Format
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CIRCULAR INTERPOLATION -

GO02 -Clockwise or GO3 Counter Clockwise? I

.:/,-‘ ,

e

R2.500

R3.000

E \(Tool Path
\

\ @

“\
&

ular interpolation‘mov @ 2 or G03?
ar Interpolation (CW) GO2

/

Part Profil

Mill Lesson 7 -3
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CIRCULAR INTERPOLATION -

.:/‘

dius = 0.5

77
77,

® \(Tocﬂ Path
5

Page 66
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CIRCULAR INTERPOLATION -

I, J and K Values are measured from the tool start to the center of the arc
1, Jand K values are INCREMENTAL
I= X Axis J =Y Axis K= Z Axis

1.0” Diameter End Mill

Radius = 0.5

Tool Path

/f/

\
XN 7N

P

Q@
% tal distances fr of cut to the center of the programmed

tal distance along &the start of the arc to the center of the

C!

. What are the

from the start of the arc to the center of the

B to the centre of the circle: | J

C to the centre of the circle: D to the centre of the circle: | J

Mill Lesson 7 - 5 Page 67




LESSON-7 - CIRCULAR INTERPOLATION -

=  What does the block of code look like moving from D to B clockwise?
= G02X3.0Y013.0J0

=  What does the block of code look like moving from A to D counterclockwise?
= GO03X-3.0Y01-3.0J0

Radius = 0.5

art of the arc to the center of the arc being machined —

=  Work out the follc ar interpolation blocks
C to D Clockwise: D to C Counterclockwise:

A to A Clockwise: B to C Counterclockwise:
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LESSON-7 - CIRCULAR INTERPOLATION -

= The center of the circle has now been changed to X5.0 Y5.0
=  What does the block of code look like moving from D to B clockwise?
= G02X8.0Y5.013.0J0
=  What does the block of code look like moving from A to D counterclockwise?

= GO03X2.0Y5.01-3.0J0

1.0” Diameter End Mill

Radius = 0.5

t art of the arc to the center of the arc being machined —

| and J values?

=  Work out the follc
C to D Clockwise:

ar interpolation blocks
D to C Counterclockwise:

A to A Clockwise: B to C Counterclockwise:

To cut a complete circle of 360°, you do not need to specify an end point X, Y, or Z. Just program |, J, or K to

define the centre of the circle.
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LESSON-7 - CIRCULAR INTERPOLATION -

Work out the following circular interpolation blocks

PROGRAM CIRCULAR INTERPOLATION USING ABSOLUTE AND INCREMENTAL IN DIRECTION SHOWN

RAi ABSOLUTE
X- X+ START POINT | X Y
A (0,0 END POINT X Y
/ |G X Y | J
R=2
INCREMENTAL

START POINT | X Y
END POINT

START

X- STAR (-

ABSOLUT

INCREMENTAL
START POINT | X Y
END POINT X Y

|G X Y | J
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LESSON-7 — CIRCULAR INTERPOLATION

Review the CNC program below that machines the contour.

e The cutter being used is a 0.5” diameter end mill.

e X0 YO0 is the lower left corner of the part.

e Start position lower left corner, machines clockwise.

e The blocks of CNC code are made up of GO1 and a GO2 moves.

e Note that the GO2 move to machine the 0.5” and 0.25” radius can use either I and J values or R for
the radius.

All circular interpolation moves are defined using three pieces of information.
1. DIRECTION OF TRAVEL: CLOCKWISE G02, COUNTER CLOCKWISE G03

2. ARCEND POINT

3. ARC CENTER: INCRE TA FROM START POINT TO ARC CENTER (I, J, K)

,‘00

+X

.5 Dia End Mill
rt Point

N160 G1 X-.25 Y-.25 (s
N170Y1.5
N180 G2 X.5Y2.25 .75
N190 G1 X2.75

| = The Incremental distance along the X axis
from the start of the arc to the center of the
programmed arc

N200 Y.25 J = The Incremental distance along the Y axis
N210 G2 X2.25 Y-.25 I-.5 JO. (OR R0.25) from the start of the arc to the center of the
N220 G1 X-.25 programmed arc
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LESSON-7 — CIRCULAR INTERPOLATION

Review the CNC program below that machines the contour.

e The cutter being used is a 0.5” diameter end mill.

e X0 YO0 is the center of the part.

e Start position is the upper right, machines clockwise.

e The blocks of CNC code are made up of GO1 and a GO2 moves.

e Note that the GO2 move to machine the radii can use either I and J values or R for the radius.

.5 Dia
End Mill
Start Point

~——1.25TYP

for Radius Values

G1 X1.5 Y1.0 (start position)

N170Y-.25

N180 G2 X.25 Y-1.5 R1.25
N190 G1 X-.75 N190 G1 X-.75
N200 G2 X-1.5Y-.751 N200 G2 X-1.5 Y-.75 R.75
N210 G1Y.875 N210 G1Y.875
N220 G2 X-.875 Y1.5 1. N220 G2 X-.875 Y1.5 R.625
N230 G1 X1. N230 G1 X1.
N240 G2 X1.5Y1.10. J-.5 N240 G2 X1.5 Y1.R.5

To cut a complete circle of 360°, you do not need to specify an end point X, Y, or Z. Just program |, J, or K to
define the centre of the circle.
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LESSON-7 — CIRCULAR INTERPOLATION

Review the CNC program below that machines the contour around the inside of the pocket.

e The cutter being used is a 0.5” diameter end mill.

e X0 YO0 is the center of the part.

e Start position is the upper right, machines contour counter clockwise.

e The blocks of CNC code are made up of GO1 and a GO3 moves.

e Note that the GO3 move to machine the radii can use either I and J values or R for the radius.

0.5 Dia End Mill
Start Point ‘\

for Radius Values
0 G90 G54 X.75 Y1. AO. S2500 M3
N50 G43 H4 2.35
N60 G1Z.12 N60 G1 Z.125 F15.
N70 X-.875 N70 X-.875
N80 G3 X-1.Y.875 10 Radius) N80 G3 X-1. Y.875 R.125 (0.375 Radius)
N90 G1Y-.75 N90 G1 Y-.75
N100 G3 X-.75 Y-1.1.25 adius) N100 G3 X-.75 Y-1. R.25 (0.5 Radius)
N110 G1 X.25 N110 G1 X.25
N120 G3 X1.Y-.2510. J.75 (1.0 Radius) N120 G3 X1. Y-.25 R.75 (1.0 Radius)
N130 G1Y.75 N130 G1Y.75
N140 G3 X.75 Y1. 1-.25 JO. (0.5 Radius) N140 G3 X.75 Y1. R.25 (0.5 Radius)
N150 GO Z2.35 N150 GO Z.35

Mill Lesson 7 - 11 Page 73



LESSON-7 — CIRCULAR INTERPOLATION

Review the program to machine the contour shown below.

Material: Aluminum 6061
Surface Feet Minute= 400

.5 Dia End Mill
Start Point

Tool #4 (@.500” Flat End Mil!) — Mill the profile

3.82xSFM/D=

Spindle Speed RP

"N10.620

N20 T4 M6

N25 GO G90 G54 X-.2

N40 G1 Z-.2

N45 X2.5

95 G91 G28 Z0.
100 G28 X0. YO.

N50 G3 X2.75Y.510. J.25

N55 G1Y1.75

N105 M30

Page 74
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LESSON-7 — CIRCULAR INTERPOLATION

Create the program to machine the contour shown below.

3.000

s

+F

& — ..

Tool #4 (@.500” Flat End Mill) — Mill the profile

L @ .5 Endmill

Start miling here in Absolute mode
[Counter Clockwise)

Material: Aluminur

RPM = 18.336

t hand corner

Mill Lesson 7 - 13
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LESSON-7 — CIRCULAR INTERPOLATION
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LESSON-8 - CNC - PART #9
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LESSON-8 - CNC - PART #9

= The Machining Process

*  @.500” Endmill - Tool # 4 - 3056 RPM Feedrate 18 IPM
=  Machine the 2.25” square with the 0.375” corner radii - 0.0625” depth
=  Machine the circular 2.25” and 1.25”diameter circular profile - 0.125” depth

*  @.125” Endmill - Tool # 1- 5000 RPM Feedrate 7 IPM
= Drill the @ .125” holes through the part (4 places)
* Note: The 3.125” Endmill is designed for center cutting machining. No center drilling or pilot hole is

required.

R375 (4) ~\

CNC - Part #9

SCALE: 1.000

MATL: 3 x 3 x .25 ALUMINUM - Teo61

DRW BY: MM. | DATE: 24-Mar-11

Mill Lesson 8 -3
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LESSON-8 - CNC - PART #9

= WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART

= XOYOis at the center of the part
=  Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1
= Climb mill the inside contours

R375 (4) B\

UR HOLES
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LESSON-8 - CNC - PART #9

=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART

= XOYO is at the center of the part
= Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1

= Climb mill
+Y
+

'ARIOUS

R375 (4) B\

OUT THE ABSOL
IONS OF THE 0.5” DI

Mill Lesson 8 - 5 Page 81



LESSON-8 - CNC - PART #9

= CREATE THE PROGRAM TO MACHINE THE PART
= Use a0.5” diameter End Mill Tool # 4
= Speed = 3050 Feed rate =20 IPM
= Use a0.125” diameter End Mill Tool # 1
= Speed = 5000 Feed rate =7 IPM
= XOYO is at the center of the part
= 7=0is the top of the part.
= Climb mill
= Type up your program and check it for correctness using the Backplot software.

%
013 ( CNC PART #9)

N10 G20
GO0 G17 G40 G49 G80 G0 (MA

AULT SETTING)

Page 82 Mill Lesson 8 - 6



LESSON-8 - CNC - PART #9 - Continued
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LESSON-8 - CNC - PART #10

LWz 31va | WW AS M

19091 - WINNIWNTY S * £ * E-LINVW

000 41¥I5

Ol# HEd - DND

WODHePnasuWyD
S’ —

G
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LESSON-8 - CNC - PART #10

= The Machining Process
*  @.500” Endmill - Tool # 4 - 3056 RPM Feedrate 18 IPM
= Machine the open slot with the 0.375” fillet radii - 0.125” depth
»  @.125” Endmill - Tool # 1 - 5000 RPM Feedrate 7 IPM
= Drill the @ .125” holes through the part (4 places)
* Note: The 3.125” Endmill is designed for center cutting machining. No center drilling or pilot hole is
required.

125
(4) g"Iz'sHFlU \ 3.0

EQUI SPACED
45

CNC - Part #10

5 E 1.000
tor. COM MATL- 3 x 3 x 25 ALUMINUM - T6061
DRW BY: MM. | DATE: 24-Mar-11

¢

+X
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LESSON-8 - CNC - PART #10

WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART
= XOYOis at the center of the part
=  Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1

Page 86

(4) TH FIL.I _\

EQUI SPACED
45"

3.0

/—Xﬂ"fﬂ

|

375

2.25

3 A\ ?é

. ORK OUT THE ABSOL

AND Y COORDINA

¢

50

FOUR HOLES

‘DWN

2

Mill Lesson 8 - 10



LESSON-8 - CNC - PART #10

=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART

= XOYO is at the center of the part
= Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1

= Climb mill
(4) THFIU \ = 3.0 =
EQUI SPACED \
45°
/—Kﬂ"f{]
T \ P
15 éﬁ 375

I - \‘-
(3100 - R375
K OUT THE ABSOLUT DY COORDINATES FOR.THE

, ONS OF THE 0.5’ D IETER END MIL
G90 \ X

6\'
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LESSON-8 - CNC - PART #10

= CREATE THE PROGRAM TO MACHINE THE PART
= Use a0.5” diameter End Mill Tool # 4
= Speed = 3050 Feed rate =20 IPM
= Use a0.125” diameter End Mill Tool # 1
= Speed = 5000 Feed rate =7 IPM
= XOYO is at the center of the part
= 7=0is the top of the part.
= Climb mill
= Type up your program and check it for correctness using the Backplot software.

%

0003

N10 G20

N20 GO0 G17 G40 G49 G80 G90 (MA

AULT SETTING)
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LESSON-8 - CNC - PART #10

X
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T i T
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I ..
3{] _L vt : :__'é‘:"‘:' ___________ 25
X0 ¥0 — \ i /
A ! e
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\' 3 ' i
——— 25 = \
@..125,.{4) THRU
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LESSON-9 - CNC - PART #11

=W 31va | WWW A M

19091 - WNNIWNTY ST * £ * £ UIVW

0001 3125

Li# HEd - DND

WODH0PNIsUlIAYD

S’
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LESSON-9 - CNC - PART #11

= The Machining Process
*  @.500” Endmill - Tool # 4
=  Machine the profile with the .125” radii at Z-.125” deep — 1 Cut
= Machine the circular 2.5” diameter circular profile — 1 Cut
*  @.125” Endmill - Tool # 1
= Drill the @ .125” holes through the part (4 places)
* Note: The 3.125” Endmill is designed for center cutting machining. No center drilling or pilot hole is
required.

R125 (4) \
I,

!

CNC - Part #11

SCALE: 1000
MATL: 3 x 3 x 25 ALUMINUM - T6061
DRW BY: MM | DATE: 24-Mar-11

ctor. COM
0' %
: > +X
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LESSON-9 - CNC - PART #11

= WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART

= XOYOis at the center of the part
=  Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1

R125 (4) \_3_1_5 4E_‘

I T

FOUR HOLES
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LESSON-9 - CNC - PART #11
=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART

= XOYO is at the center of the part

= Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1
= Climb mill

= 3.0 &=

R125 (4) \_5_1_5 43‘
) , i L
T
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LESSON-9 - CNC - PART #11

= CREATE THE PROGRAM TO MACHINE THE PART
= Use a0.5” diameter End Mill Tool # 4
= Speed = 3050 Feed rate =20 IPM
= Use a0.125” diameter End Mill Tool # 1
= Speed = 5000 Feed rate =7 IPM
= XOYO is at the center of the part
= 7=0is the top of the part.
= Climb mill
= Type up your program and check it for correctness using the Backplot software.

%

0003

N10 G20

N20 GO0 G17 G40 G49 G80 G90 (MA

AULT SETTING)
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LESSON-9 - CNC - PART #11 - Continued
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LESSON-9 - CNC - PART #12
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LESSON-9 - CNC - PART #12

= The Machining Process
*  @.500” Endmill - Tool # 4- 3050 RPM Feedrate 20 IPM
= Machine the profiles with the .125” and .25 radii.
=  Machine the circular 0.625” diameter through hole. Sink to depth at center and use circular
interpolation to finish the bore.
»  @.125” Endmill - Tool # 1- 5000 RPM Feedrate 7 IPM
= Drill the @ .125” holes through the part (8 places)
*= Note: The 3.125” Endmill is designed for center cutting machining. No center drilling or pilot hole is
required.

R250 (4)
R125 (4) \

1.5

CNC - Part #12
SCALE. 1.000
Instructor. COM MATL 3 x 3 x .25 ALUMINUM - T6061
DRW BY: MM, | DATE: O3-Aug-1

4
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LESSON-9 - CNC - PART #12

=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART

X0YO0 is at the center of the part
Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1

R250 (4)
R125 (4)

—

|

|

2.625

Page 100
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LESSON-9 - CNC - PART #12

WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS
POSITIONS TO MACHINE THE PART

X0YO0 is at the center of the part
Use a 0.5” diameter End Mill Tool # 4 and a 0.125” diameter End Mill Tool # 1
Climb mill

R250 (4) L
R [~
I T
.- o) J
©

X0Y0 — ! .
' ] LH{

¢

DINATES F()Ré S
a rdinates
X
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LESSON-9 - CNC - PART #12

= CREATE THE PROGRAM TO MACHINE THE PART
= Use a0.5” diameter End Mill Tool # 4
= Speed = 3050 Feed rate =20 IPM
= Use a0.125” diameter End Mill Tool # 1
= Speed = 5000 Feed rate =7 IPM
= XOYO is at the center of the part
= 7=0is the top of the part.
= Climb mill
= Type up your program and check it for correctness using the Backplot software.

%

0003

N10 G20

N20 GO0 G17 G40 G49 G80 G90 (MA

AULT SETTING)
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LESSON-9 - CNC - PART #12 - Continued
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CNC PROGRAMMING
WORKBOOK

—— _PointD ——Point E (End)
-~ 1732 [ XXXX,2.375) | (2.8752.375)
/ / \‘!l III..-’ f \'ﬁl
N ' -
30.0° e /)
-‘7 = - < =
Point C II"PQ
(375 YYYY)— . " (1.732,2.000)
N

v

|_ <

_‘K ﬁ — P 2.000 =

= 0,1.000
A ( J
1.000 !
|~ Q(0,9)
@.750 }\@ N
Endmill _ |
' 2.500 250 —== -
Point A (Start) j Point B
(-.575,-.200) / (21375, -.200)

LESSON-10
CUTTER COMPENSATION

caminstructor
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LESSON-10 - CUTTER COMPENSATION

the left or right the distance of the cutter radius. When cutting angled geometry, substantial

can program the part as if the center of the cutter will be travelling along the geometry.

Cutter Compensation is used to offset the center of the cutter and move the cutter either to

computations are required to determine the center of the cutter. Using Cutter Compensation, you

G40 CUTTER COMPENSATION CANCEL

G40 will cancel the G41 or G42 cutter compensation commands.

G41 CUTTER COMPENSATION LEFT

G41 will action cutter comp
compensate for the radius of th
size from the DIAMETER/

must also be programmed to select the correct t

display register.

ool is moved to the left of the programmed path t

G41 Lefto

G41 : Tool is moved to the left of the profile (e.g. Outside Profile shown as above)
G42 : Tool is moved to the right of the profile (e.g. Inside Profile shown as above)
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LESSON-10 - CUTTER COMPENSATION

[, PoiniD Point E (End
- 1.732 ff (X.XXX, 2.375) f {2.875,2(.375%
1 I/ / |
30.0° \ /
]
Point C .
(375, Y.YYY) - - (1.732,2.000)
|’ 3
: A 2.000 -
Pl
T =y (0,1.000)
1.000
O(0,0) 1
@ .750
Endmill
2.500 250 —w= ——
Point A (Start) Point B
(-.575,-.200) (2375, -.200)
Without Cutter Compensation Using Cutter Compensation
% %
010011 010012
N1 T12 MO6 (3/4” Flat Endmill) N1 T124M06(3/4” Flat Endmill)
N2°G90 G54 GO0 X-.575(Y=200 S1500 MO03 N2 G90 G54 GO0 X-.575 Y-.200 S1500 MO03
N3 G43 H12 Z2. N3 G43 H12 Z2:
N4 Z.1 N4 Z.1
N5 GO1 Z-.25 F10. N5 GO1 Z-.25 F10.
N6 X-.375 (Point B) N6 G41 X0. D12 (Origin)
N7 Y?2.2??? (Point C) N7 Y1.0(P1)
N8 X?.?2?2 Y2.375(Point D) N8 X1.732 Y2.0 (P2)
N9 X2.875 (Point.E) N9 X2.875
N10 MO5 N10 G40 MO05
N11 GOO Z2. N11 GOO Z2.
N12 G91 G28 Z0. (Machine Home Z-Axis) N12 G91 G28 Z0. (Machine Home Z-Axis)
N13 G28 X0. YO0. (Machine Home X,Y-Axis) N13 G28 X0. YO0. (Machine Home X,Y-Axis)
N14 M30 N14 M30
% %
The Cutter Compensation (G41) will reflect the actual part geometry (O, P1, P2..) instead of Cutter
Centers (Point B,C,D & E)
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LESSON-10 - CNC - PART #13
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LESSON-10 - CNC - PART #13

The Machining Process

@.750” Endmill - Tool # 6

=  Machine the profile and pocket using cutter compensation

= 0.750” diameter end mill Spindle Speed = 2100 Feed rate = 25 IPM
@.375” Spot Drill - Tool # 6

=  Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

@.201” Drill - Tool # 8

= 0.201” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
@.25”-20 UNC Tap - Tool # 9

= 0.250-20 UNC Tap Spindle Speed = 1000 Feed rate = 50 IPM

CNC - Part #13

SCALE: 1.000
MATL: 3 x 3 x 25 ALUMINUM - T6061
DRW BY: MM. | DATE: 24-Mar-11

125
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LESSON-10 - CNC - PART #13

= WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART
= XOYO is at the lower left corner of the part

= 3.0 =
————— 2875 ———=
— 1.0 R5 (2)
s 1 == 25 -20 UNC 25
: f (2)THRU 5 l
Al

|

+X

RS

THE TWO HOLES
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LESSON-10 - CNC - PART #13
=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART - CONTOUR
= XOYO is at the lower left of the part

= 3.0

———— 2875 ——=
— 1.0 R5 (2)
A == 25 -20 UNC 25

5 l

25 f (2)THRU
Y T +Y

/1

b 75 % 2.000
. | l +X
P | O Rsoo
1 {I [ "
25 =4 17 R25 ¢

25 ' OCKET
= 11 : TH .125
R T THE ABSOLU1 OORDINATES FOR TF ARIOUS
p A ] ONS OF THE 0.75 'DIA END MILL TO MA NE.THE CONTOUR

L ox G90 Y

"' :

&

VS
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LESSON-10 - CNC - PART #13
=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART - POCKET
= XOYO is at the lower left of the part

3.0
_——— 2875 — =
= 1.0 R5 (2)

1 —=~|=— .25 -20 UNC

. 25
25 r (2)THRU 5 l

¢

DINATES FOR

D MILL TO MACHI OCKET
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LESSON-10 - CNC - PART #13

The Machining Process
@.750” Endmill - Tool # 6

= Machine the profile and pocket using cutter compensation
= 0.750” diameter end mill Spindle Speed = 2100 Feed rate = 25 IPM

@.375” Spot Drill - Tool # 6

CREATE THE PROGRAM TO MACHINE THE PART

= Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

@.201” Drill - Tool # 8

= 0.201” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM

@.25”-20 UNC Tap - Tool # 9

= 0.201” diameter Drill Spindle Speed = 1000 Feed rate = 50 IPM

%

0888

N10 G20

N20 GO0 G17 G40 G49 G80 G9

N30

" 4
F DEFAULT SETTING)

Lesson 10-9
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LESSON-10 - CNC - PART #13 - Continued

S
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LESSON-10 - CNC - PART #14

€l-eW-0l -31vd | WW A8 M

19091 - WNNIWMNTV S * £ X £ TIVW

0001 -J1VIOS

vl# Hed - DND

Gcl  H1d43d
13IX00d
T4 |_
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LESSON-10 - CNC - PART #14

The Machining Process
@.750” Endmill - Tool # 6

Machine the profile and pocket using cutter compensation
0.750” diameter end mill Spindle Speed = 2100 Feed rate = 25 IPM

@.375” Spot Drill - Tool # 6

Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

@.201” Drill - Tool # 8

0.201” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM

@.25”-20 UNC Tap - Tool # 9

0.201” diameter Drill Spindle Speed = 1000 Feed rate = 50 IPM

—1/4-20 UN
THRU

.75 1.75

TOP OF PART

— CNC - Part #14

| SCALE 1000

Instructor. COM

MATL: 3 x 3 x .25 ALUMINUM - TeO61

DRW BY: M.M.

| DATE: 10-Mar-13

Page 116
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LESSON-10 - CNC - PART #14

=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART
= XO0YOis at the lower left of the part

— 30 =

I}’—a1_125 e—‘

| | I

L
w 2375
126 —{p=— 2 5(7) |
| 2

4 1*
- 00 "‘
s‘ Ny

~1.125

K
—=—

+X

S

. WO HOLES
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LESSON-10 - CNC - PART #14

= WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART - CONTOUR
= XOYO is at the lower left of the part

—1.125
1.125
] 1T —R25
U D
<k 2.375
R | RS() +Y
s 0 T , 11
1.25
iy $ +X
1 ]
‘ _ W I
50 - '. [ 5" 50
25 20 UNC  |N—POCKET ¢

DEPTH .125

2) THRU

— 75 ——=

. ' E ABSOLUTE XAN ODORDINATES FOR
OF THE 0.75”.DI/ R END MILL TO MACHINE
X G0 |

),
N

10

11

Page 118 Lesson 10 - 14



LESSON-10 - CNC - PART #14
=  WORK OUT THE ABSOLUTE X AND Y COORDINATES FOR THE VARIOUS

POSITIONS TO MACHINE THE PART - POCKET
= XOYO is at the lower left of the part
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LESSON-10 - CNC - PART #14

CREATE THE PROGRAM TO MACHINE THE PART

The Machining Process

@.750” Endmill - Tool # 6

= Machine the profile and pocket using cutter compensation

0.750” diameter end mill Spindle Speed = 2100 Feed rate = 25 IPM
@.375” Spot Drill - Tool # 6

Spot Drill Spindle Speed = 2750 Feed rate = 11 IPM

@.201” Drill - Tool # 8

0.201” diameter Drill Spindle Speed = 4500 Feed rate = 15 IPM
@.25”-20 UNC Tap - Tool # 9

0.201” diameter Drill Spindle Speed = 1000 Feed rate = 50 IPM

%

000

3

N10

G20

N20

~»
GO0 G17 G40 G49 G8O G NE DEFAULT SETTING)

N30

s
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LESSON-10 - CNC - PART #14 - Continued

S
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Extra CNC Programming Exercise #2
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Extra CNC Programming Exercise #3
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Extra CNC Programming Exercise #4
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Extra CNC Programming Exercise #5
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Extra CNC Programming Exercise #6
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Extra CNC Programming Exercise #7

Instructions:

Create your own design.

The material size: 6” x 1.5” x .125” Aluminum
The part is held in the vise.

Locate the part flush with the left hand side of the vise jaw.

X0 YO is the top left hand corner of the material.

Z0 is the top of the material.

Center Drill is used as an engraving tool to machine the letters.
Spindle Speed: 5000 rpm

Feedrate: 12 in/min

Depth of Cut : -0.025”

Center Drill 2 mounting holes usi ed Cycle

Depth of Cut: -0.25
Minimum of five letters

You can use the suggeste & size or create your own lettering design.

Lo NOU R WNRE

S
N = o

IR
A W
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Appendix — Preparatory Functions — G-Codes

GOO RAPID POSITIONING MOTION

GO1 LINEAR INTERPOLATION MOTION

GO2 CIRCULAR INTERPOLATION MOTION - CLOCKWISE

GO3 CIRCULAR INTERPOLATION MOTION - COUNTECLOCKWISE

G04 DWELL

GO09 EXACT STOP

G10 PROGRAMMABLE OFFSET SETTING

G12 CW CIRCULAR POCKET MILLING

G13 CCW CIRCULAR POCKET Mi

G17 CIRCULAR MOTION XY P. N (GO2 or G03)

ECTION (G02 or GO3)

)

T

H G28 REF. POINT

MEASUREMEN

G40 CUTTER COMPENSATIO

G41 2D CUTTER COMPENSA

G42 2D CUTTER COMPENSATION,

G43 TOOL LENGTH COMPESATION POSITIVE (H, Z)

G44 TOOL LENGTH COMPENATION NEGATIVE (H, Z)

Mill Appendix - 9
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Appendix — Preparatory Functions — G-Codes

G47 TEXT ENGRAVING (X, Y, Z, R, 1, J, P, E, F)

G49 TOOL LENGTH COMPENSATION CANCEL G43/G44/G143)

G50 SCALING G51 CANCEL

G51 SCALING (X, Y, Z, P)

G52 WORK OFFSET COORDINATE POSITING

G52 GLOBAL WORK COORDINATE OFFSET SHIFT

G52 GLOBAL WORK COORDINATE OFFSET SHIFT

G53 MACHINE COORDAINTE POSITIONI

-MODAL (X, Y, Z, A, B)

G54 WORK OFSET COORDIANT ITI

G19,X,Y,Z R)

G69 ROTATION

G70 BOLT HOLE CIRCLE with
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Appendix — Preparatory Functions — G-Codes

G71 BOLTHOLEARC with a CANNED CYCLE (1, J, K, L)

G72 BOLT HOLES ALONG AN ANGLE with a CANNED CYCLE (I, J, L)

G73 HIGH SPEED PECK DRILL CANNED CYCLE (X, Y, A, B,Z,1,J,K,Q, P,R, L, F)

G74 REVERSE TAPPING CANNED CYCLE (X, Y, A, B, Z,J,R, L, F)

G76 FINE BORING CANNED CYCLE (X, Y,A,B,Z,1,J,P,Q,R, L, F)

G77 BACK BORE CANNED CYCLE (X,Y,A,B,Z,1,J,Q,R, L, F)

G80 CANCEL CANNED CYCLE

G81 DRILL CANNED CYCLE (X, Y, A, B, Z,

G82 SPOT DRILL/COUNTERBOR N ,Y,A,B,ZP,R,LF)

G83 PECK DRILL CANNED CY 1,3, K Q P, R, L, F)

B,ZJR LF)

IF)

ILIF)

7 YI AI BI ZI RI L’ F)

ELL, MANUAL RETRA

XI YI AI BI ZI PI RI L’ F)

ED CYCLE (X, Y,

G99 CANNED CYCLE “R” PLANE RETURN

Mill Appendix - 11
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Appendix — Miscellaneous Functions — M-Codes

MO0 PROGRAM STOP

MO1 OPTIONAL PROGRAM STOP

MO02 PROGRAM END

MO3 SPINDLE ON CLOCKWISE

MO04 SPINDLE ON COUTERCLOCKWISE

MO5 SPINDLE STOP

MO06 TOOL CHANGE

MO8 COOLANT ON

MO9S COOLANT OFF

M19 ORIENT SPINDLE (P, R)

M21-M28 OPTIONAL USER ACE WITH M-FIN SIGNAL

M50 EXECUTE PALLET CHANGE

Page 134 Mill Appendix - 12



Appendix — Miscellaneous Functions — M-Codes

M51-M58 OPTIONAL USER M CODE SET

M59 OUTPUT RELAY SET (N)

M61-M68 OPTIONAL USER M CODE CLEAR

M69 OUTPUT RELAY CLEAR (N)

M75 SET G35 OR G136 REFERENCE POINT

M76 CONTROL DISPLAY INACTIVE

M77 CONTROL DISPLAY ACTIVE

M78 ALARM IF SKIP SIGNAL FOUND

M79 ALARM IF SKIP SIGNAL NO

M80 AUTOMATIC DOOR OPE}

M81 AUTOMATIC DOORC

M95 SLEEP MO

M96 JUMP IF NO SIGNAL (P, Q

M97 LOCAL SUB-PROGRA

M98 SUB-PROGRAM CALL (P, L)

M99 SUB-PROGRAM/ROUTINE RETURN OR LOOP

M109 INTERACTIVE USER INPUT (P)
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Standard Drill Sizes - Inches

Drill Decimal  Drill Decimal  Drill Decimal  Drill Decimal
Size ° Equiv. °~ Size ° Equiv. °~ Size ° Equiv. ~ Size ~ Equiv.
80 = .0135 43 = .089 8 =.199 25/64 = .3906
79 = .0145 42 = .0935 7 = .201 X = .397

1/64 = .0156 3/32 = .0938 13/64 = .2031 Y = .404
78 = .016 41 = .096 = .204 13/32 = .4063
77 = .018 40 = .098 = .2055 Z=.413
76 = .020 39 = .0995 4 = .209 27/64 = .4219
75 = .021 38 = .1015 =.213 7/16 = .4375
74 = .0225 37 = .104 7/32=.2188  29/64 = .4531
73 = .024 36 = .1065 =.221 15/32 = .4688
72=.025 7/64 = .1094 1=.228 31/64 = .4844
71=.026 35 =.110 =.234 1/2 = .500
70 = .028 34= 111 15/64 = .2344  33/64 = .5156
69=.0292 <, 33=.13" B = .238 17/32 = .5313
68 = .031 32'=.116 C=.242 35/64 = .5469

1/32=.0313 . 31=.120 D = .246 9/16 = .5625
67 = .032 1/8'=.1250  1/4 (E) = .250 37/64 = .5781
66=.033 . | 30=.1285 = .257 19/32 = .5938 [ |
65 =4035 29 = .136 = .261 39/64 = .6094
64=.036 ), ) 28=.1405 ‘7/64 = .2656 5/8=4625 ), |
63 = .037 9/64 = .1406 = .266 41/64 = .6406

“62=.038 27 = 1" VI =272 21432 = .6563)
61=.039 26 = 277 43/64 = .6719
0=.040 !1” K =.281  “11/16 = .6875
59 = .041 24 = 152 9/32 =.28137,. 45/64 = .7031
58=.042 A . 23=.154 L=.200  23/32=.7188
57 = .043 5/32 = .1563 M = .295 47/64 = .7344
56=.0465_ . 22 =.157 19/54‘6' 3/4 = .750

3/64 = .0469 21 = .159 = .302 49/64 = .7656
55=.052 |  20=.161 ‘5‘: 3125  25/32=.7813
54'=,.055 19 = .166 =316 51/64 = .7969

4/53=.0595 18 = .1695y . WP =.323 13/16 = .8125

1/16 = .0625 11/64 = .1719 21/64 = .3281 53/64 = .8281
522,.0635 17-.173 | Q-=.332 27/32 = .8438
51 = .067 16 = .177 = .339 55/64 = .8594
50=.070 4 15-.180, 11/32 = .3438 7/8 = .875
49 = .073 14 = 182 = .348 57/64 = .8906
48=.076 -, 13=.185 = .358 29/32 = .9063

5/64 = .0781 3/16 = .1875 23/64 =.3594  59/64 = .9219
47 = .0785 V12 = .189 U=.368 15/16 = .9375
46 = .081 11 =.191 3/8 = 375 61/64 = .9531
45 = .082 10 = .1935 V=.377 31/32 = .9688
44 =.086 = .196 W = .386 63/64 = .9844
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Inch Tap Drill Sizes

INCH SIZES - NATIONAL COARSE INCH SIZES - NATIONAL FINE
UNC UNF
TAP DRILL TAP DRILL
SIZE SIZE SIZE SIZE
#1-64 #53 #0-80 3/64"
#2-56 #51 #1-72 #53
#3-48 5/64" #2-64 #50
#4-40 #43 #3-56 #46
#5-40 #39 #4-48 #42
#6-32 #36 #5-44 #37
#8-32 #29 #6-40 #33
#10-24  #25 #8-36 #29
#12-24 #10-32  #21
1/4-20 #12-28  #15
5/16-1 1/4-28  #3
3/8-1 5/16-24 |
7/1 3/8-24
4 7/16-20
1/2-20
17/32 9/16-18
21/32
49/6
7/8

63/64

/64
/32
5

2 1-3/64
2 1-11/64
2-12  1-27/64
-3/4-12  1-43/64
2"-12 1-59/64
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Metric Tap Drill Sizes

METRIC COARSE SIZES
TAP DRILL
SIZE SIZE
1mmx .25 .75mm
1.1x.25 .85
1.2x.25 .95
1.4x.3 1.1
1.6 x.35 1.25
1.7 x.35 13
1.8x.35 1.45
2x.4 1.6
2.2 x.45 1.75
2.5x.45 5

3x.5 .
3.5x.6 9
4x.7
4.5x.7

6
6

.8
7.8
8.5
9.5

METRIC FINE SIZES

TAP DRILL
SIZE SIZE
4 mmx .35 3.6mm
4x.5 3.5
5x.5 4.5
6x.5 5.5
6 x.75 5.25
7x.75 6.25
8x.5 7.5
8x.75 7.25
8x1 7
9x1 8
10 x.75 9.25
10x1 9
10x1.25 8.8
11x1

12 x.75 11.
12x1

12x1.5 5
14x1

14 x 1.25 2.

14 x .5

24x2
26x1.5
27 x 1.5
27 x2
28x1.5
30x1.5
30x2

15
14.5
17
16
19
18.5
18
21
20.5
20
22.5
22
24.5
25.5
25
26.5
28.5
28
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CENTER DRILLING

CENTER DRILLING

Before most drilling operations take place a starting drill must be programmed to make a small
hole for the larger drill that will follow. The tool used to make the starting hole is known as a
center drill, sizes of center drills vary and the use of the different sizes is governed by the size of the
drill that will be used after. The following is a chart that will assist in choosing the proper size of
the center drill and programming the correct Z depth.

D1

T = i Number D1 D2 E L

#1 0.125 0.047 0.100 0.106
0.188 0.078 0.150 0.163
0.250 0.110 0.200 0.219
0.312 0.125 0.250 0.269
0.438 0.188 0.350 0.382

#6 0.500 0.218 0.400 0.438

the front edge of
‘Iu point). This poses a

e program from the poi the drill'so any Z depth we specify

alculation to perform based on

a
the diameter of the i ually 118°). Quite simply the

calculation is
er X Constant

Where e constant is stated in the following chart

CONSTANTS
110°= | 0.350
118°= | 0.300
120°= | 0.289
135°= | 0.207
90°= | 0.500 150°= | 0.134
100°= | 0.420 180°= | 0.000
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Discriminator Installation Instructions

Installation Instructions for Workbook users:

1. Locate the DVD/CD that came with the workbook (fixed to the back cover).
2. Insert the disc into the DVD/CD ROM tray of your computer.

3. When the AutoPlay window is displayed select Open folder to view files as shown below:
D

ﬁy DVD RW Drive (D:) Aug 22 2011

[] Always do this for software and games:

Install er run pregram from your media

4 Run CNC-Mill.exe
Published by TechSmi

General options

Cpen folder to view files
b using Windows Exgieie

Date modified

1KB
1672 KB

@] autorun
CNC-Mill

4] Libraries
b l} Documents
3 Ei DropBox

b . Music

> &L Pictures

I ] »
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Discriminator Installation Instructions Continued

5. Double-click the Discriminator21017.exe file as shown below. This will start the installation process.
Follow the instructions on the screen to complete the installation.

WIL » Computer » DVD RW Drive (D) Jun 17 2013 » Discriminator ~| 43 || Search Discriminator P
Organize ~ Burn to disc E= Eﬂ 0
l4 Downloads g Name Date modified Type Size
| Dropbox |

%= Recent Places 4 Files Currently on the Disc (2)
=5

B Desktop ﬂ DiscrimSetup21017, 6/17/13 2:44 PM Windows Installer ... 2,310 KB
T setup \ 6/17/13 2:44 PM Application 673 KB

2 Libraries
*. Documents
L5, DropBox
. Music
&, Pictures

5 Videos

m

4% Homegroup

‘& Computer
& 05(C)
‘ -~ DVD RW Drive (D:) Jun 17 2013

Installation Instru

f the Online C as shown below:

r Online Course users: ‘ 0

My Cours K Log-Out

Course Intro "/

® Table of Contents

Introduction

urse” section on this page and click on the

iminator installation file. Make sure you save the file to a

an be easily located.

3. Once the file has do : e it and double-click the Discriminator.zip file to extract the
installation files onto you drive. Make sure you extract the files into a new folder on your hard
drive and remember where the folder is located.

4. Open the folder the files were extracted to and double click on Discriminator21017.exe.

5. Follow the instructions on the screen.
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